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Part I
OVERVIEW
Real Sound Lab’s CONEQ™ is a technology to measure and equalize the acoustic power
frequency response (APFR) of electro-acoustic transducer devices, such as loudspeakers.
With CONEQ™ every loudspeaker sounds better – clear, natural, and without attenuations
– within its whole frequency range. The CONEQ™ technology is applied in two steps. First,
a precise measurement of how well the loudspeaker transmits energy at each frequency is
done, and a compensation filter is automatically produced. Second, the filter is applied to
the audio signal by any of the software or hardware tools supporting CONEQ™.

Thismanual describes all the features of the CONEQ™Workshop application– the tool for
measuring and filter synthesis. For a quick introduction to CONEQ™ Workshop we suggest
reading the CONEQ™ Workshop Quickstart Guide first. Return to this manual after having
done the first measurements to learn about all the features in detail.

The screenshots in this manual are taken on the Windows operating system. The corre-
sponding screens on Mac OS will look similar and the functionality on both operating sys-
tems is the same.
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APPLICATION REQUIREMENTS
SUPPORTED OPERATING SYSTEMS

CONEQ™ Workshop has been tested to run on the following operating systems:

Windows XP, Service Pack 3

Windows Vista

Windows 7

Mac OS X 10.5.8

Mac OS X 10.6.8

Mac OS X 10.7.2

The CONEQ™Workshop forWindows requiresMicrosoft .NET framework 2.0 and the set-
up program will install the framework if necessary.

AUDIO REQUIREMENTS

CONEQ™ measurement is done by sending a series of test signals to a device-to-be-
measured (typically, a loudspeaker) and recording the output of the device (typically, using
amicrophone). Proper measurement is crucial to achieve the best possible results with the
CONEQ™ technology. That is why several points about the system set-up must be taken
into account before using CONEQ™ technology:

The sound card or audio interface (audio device) and, if necessary, drivers must be
properly installed and configured;

An omnidirectionalmeasurementmicrophonewith flat free-field frequency response
must be used. An acceptable alternative is to use an omnidirectionalmicrophonewith
a known, electronically available individual frequency response curve in a format that
is compatible with CONEQ™ Workshop;

The audio device must be working properly and be compatible with the CONEQ™
Workshop application. The audio device must be capable of simultaneous (full du-
plex) playback and recording, and both the audio device and the measurement mi-
crophone, along with the connecting cables, must be in perfect working order;

A loop-back test should be performed to check for any undesired disturbances in the
playback/recording path.

Failure to take the steps mentioned above will increase the probability of incorrect
measurements, which may cause undeserved disappointment about the achieved results,
CONEQ™ Workshop software, and CONEQ™ technology in general.
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DIFFERENCES BETWEEN CONEQ™ WORKSHOP EDITIONS
LICENSES

There are three editions of the CONEQ™ Workshop application:

CONEQ™ Workshop Unlimited

CONEQ™ Workshop Annual

CONEQ™ Workshop Limited

All editions are functionally equal but the Annual and Limited editions have limitations
on the usage time. The Annual edition will work for a year (53 weeks) from its activation.
To continue using CONEQ™Workshop, a new license must be acquired. The Limited edition
is similar to Annual but will work for 30 days from its activation.

FEATURES

Table 1: List of major features of CONEQ™ Workshop
Filter sampling frequency (kHz) 0.5 / 1 / 2 / 8 / 16 / 32

/ 44.1 / 48 / 88.2 / 96
Filter resolution (number of taps) 1024 and 4096
Support for APEQ™ hardware equalizers Yes
Support for CONEQ™ P2/P8/P2pro/P8pro plug-ins Yes
Support for CONEQ™ COMPATIBLE third-party products Yes
Adjustable limits for maximum gain/attenuation Yes
Parametric equalizer for defining target curve Yes
Graphic equalizer for defining target curve Yes
Custom target curve files Yes
Microphone calibration file support Yes
Composite (averaged) measurement Yes
Measurement from pre-recorded file Yes
Phase Filters Linear / Minimum
Changeable smoothing (octave) 1/6 / 1/3 / 1/2 / 1
Changeable test signal periods 4
Changeable time window 8 + custom

USING COPY-PROTECTION DEVICE

CONEQ™ Workshop is protected against illegal copying using eLicenser technology. It is a
hardware based copy-protection system and the eLicenser copy-protection USB device is
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Figure 1: The eLicenser copy-protection USB device.

delivered together with the software. It must be connected to the computer before starting
CONEQ™ Workshop.

The eLicenser devices delivered with the Unlimited edition of CONEQ™ Workshop are
ready to use right out of the box. The eLicenser of the Annual and Limited editions contains
a non-active time-limited license. It must be activated to start the countdown and enable
use of the software.

To activate a time-limited license, connect the eLicenser and open the eLicenser Con-
trol Center application (Start⇒All Programs⇒eLicenser⇒eLicenser Control Center). The
connected eLicensers will appear on the list. Select the CONEQ™Workshop Annual/Limited
license and choose Actions⇒Start License Usage Period from the menu (see figure 2). Fol-
low the instructions and after successfully completing the activation process, the CONEQ™
Workshop software is ready to run.

Figure 2: Activation of the time-limited license for CONEQ™ Workshop Annual/Limited.

The activation process requires an Internet connection. If the computer where the
CONEQ™ Workshop is to be used is not on-line, then activation can be done on any other
computer after installing the eLicenser Control Center application there. The latest version
of the eLicenser Control Center application can be downloaded from http://www.elicenser.
net/en/latest_downloads.html
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STARTING CONEQ™ WORKSHOP

To start the application, use Start⇒Real Sound Lab⇒CONEQ Workshop

Figure 3: CONEQ™ Workshop in the Start menu.

CREATING/OPENING A PROJECT

To start working with CONEQ™ Workshop a project must be created. A project in CONEQ™
Workshop is a collection of measurements and filters. To create a new project select
Project⇒New from the menu.

Figure 4: The Projectmenu.

A folder selection dialogue (figure 5) will open. CONEQ™ Workshop projects are folders
on the hard disk. To create a new project, select the parent folder where the project folder is
to be stored. Then write the name of the project in the corresponding field. The full project
path, including the project folder will be shown at the bottom of the dialogue.

For instance, to save a project in the folder Measurements/MySpeakers, use the folder
selection dialogue to select the folder Measurements and enter MySpeakers as the project
name.

To open an existing project, choose Project⇒Open... from themenu and point CONEQ™
Workshop to the project folder.
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Figure 5: The new/open project dialogue.

IMPORTANT! If an existing project was created by CONEQ™Workshop 2.x then opening it will require
a conversion. The original project will be left unmodified and CONEQ™ Workshop will ask for the
location where to put the converted project. The converted projects cannot be opened with earlier
versions of CONEQ™ Workshop.

MAIN WINDOW

The main application window has the following areas:

Measurements

Parameters

Graph

The measurements list at the top left is where all measurements of the currently open
project are shown. For each measurement, all filters derived from it are shown.

The parameters area at the top right is where the parameters of the currently selected
filter andmeasurement are shown. For newly created projects with nomeasurements, this
area is empty. Parameters (such as correction range, filter resolution, low/high frequency
cut, target curve, etc.) can be changed and either applied to the current filter or used to
create a new filter.
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Figure 6: The main application window with a new project just created.

The Graph area at the lower part is where the data of the currently selected measure-
ment and filter are visualized. It features horizontal and vertical zoom. Some curve pa-
rameters (e.g. zero level or a target curve EQ) can be edited with the mouse directly in the
graph.

The next part of this document describes all the features in detail.
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Part II
REFERENCE MANUAL
Here comes the description of every function of CONEQ™ Workshop.

PROJECTS
PROJECT FOLDER

A project in CONEQ™ Workshop is a collection of measurements and filters. It is stored in
a folder with a specific file and sub-folder structure. There is a sub-folder for each mea-
surement and a further sub-folder for each equalization filter. Figure 7 shows an example
project folder structure.

Figure 7: The structure of a CONEQ™ Workshop project folder.

The project and its folder are called MySpeakers and all project-related data are stored in
this folder. The project contains two measurements – Left_1 and Right_1. Each measure-
ment is stored in an own folder within the project folder. In this case, the corresponding
folders are 001_Left_1 and 002_Right_1. Each version of the equalization filter of a mea-
surement is stored in an own folder within the folder of that measurement. In this case, the
Left_1measurement has two versions of the equalization filter stored in folders 01 and 02,
whereas the Right_1measurement has only one filter in the folder 01.

MEASUREMENT FOLDER

Eachmeasurement folder contains the recorded test signal WAV file, the calculated impulse
response data file (e.g. MySpeakers_001_Left_1_IR.IR), and the measurement informa-
tion file cfg_msr.ini. The measurement folder contains sub-folders for each equalization
filter version. The filter sub-folder names are sequential two-digit numbers (01-99).

CONEQ™ Workshop Acoustic Power Frequency Response Measurement and Equalization System v3.2.0 Reference Manual
11

www.realsoundlab.com



Figure 8: Contents of a measurement folder.

Figure 9: Contents of an equalization filter folder.

EQUALIZATION FILTER FOLDER

Each equalization filter folder contains data files for the equalization filter. Themost impor-
tant file is the CONEQ™ equalization filter file with the extension .FIR (FIR file). This is the
file that can be used by the software and hardware tools that perform CONEQ™ equaliza-
tion, e.g. APEQ™ hardware equalizer and CONEQ™ software plug-ins. The FIR file is created
automatically when the filter is created or modified.

The table 2 gives the summary of the file names of various data files in the filter folder.
Most data files of a measurement share a common part. This part consists of the project
name, an underscore, a measurement number, another underscore, the measurement
name, and the filter index. An example of a common part for the second filter of a mea-
surement named Left_1 in a project named MySpeakers is MySpeakers_1_Left_1_01. The
table 2 lists all possible file names in the filter folder and describes the contents of the cor-
responding files.

All .DAT, .GEQ, .PEQ, and .FIR files are usable as target or correction curves for other
filters and can be displayed as custom curves for comparison purposes.
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Table 2: The data files in the filter folder.
File description File name
Filter parameters cfg_flt_v3.ini
CONEQ™ equalization filter *.FIR
Combined APFR correction *_C.DAT
Expected APFR after CONEQ™ equalization *_EPR.DAT
Filter graph *_F.DAT
Inverted filter graph *_FI.DAT
Noise/Distortion *_IF.DAT
Acoustic power frequency response *_PR.DAT
Smoothed APFR with shelves *_PRS.DAT
Combined target EQ *_T.DAT
Used target EQ curves Folder Targets
Used correction curves Folder Corrections

PROJECT MENU

Figure 10: The Projectmenu.

New...

Create a new project. It was described on page 8.

Open...

Open an existing project. It was described on page 8.

Save as...

Save the current project with all the measurements and filters to another location. This is
also the supported way of renaming projects.
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IMPORTANT! Renaming only the project folder using the means of the operating system will break
the project and CONEQ™ Workshop will not be able to open it. To rename a project, open it in
CONEQ™ Workshop and use Project⇒Save as... and give it the new name.

Recent projects

Open one of the most recently used projects.

Settings...

Figure 11: The project settings window.

Open a window as in figure 11 to edit the description of the current project.

Exit

Close the CONEQ™ Workshop application.

MEASUREMENTS

The measurement list at the top left of the main window (figure 12) displays the measure-
ments in the current project. For each measurement, a list of filters that are derived from
the measurement is displayed. If a filter has a description (see page 23) then that is shown
in parenthesis. In the measurements list only the filters can be selected. The currently se-
lected filter is called the current filter in this document. The measurement from which the
current filter is calculated is called the current measurement.

Click the New... button to initiate a newmeasurement (see page 15). Click the Compos-
ite... button to create an average of several previousmeasurements (see page 19). Click the
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Figure 12: The measurement area of the main window.

From file... button to create a measurement from a pre-recorded WAV file (see page 19).
This is useful for importing a singlemeasurement from another CONEQ™Workshop (2.x and
3.x) project.

NEW MEASUREMENT

Figure 13: The new measurement window.

The newmeasurement window (figure 13) allows taking a newmeasurement according
to given parameters.
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Playback device

A playback device and a channel must be selected. That is the device and channel to which
the test signal will be sent. Typically it will be the sound card connected to speakers that are
to be measured. The output volume should be adjusted to normal listening level. The pre-
ferred way of adjusting the volume is by using the means of the audio interface or amplifier
but it can be done also using the slider control below the list of playback devices.

The default test signal output level slider setting is -30dBFS to prevent very high output
signal levels. However, this control is purely digital and affects the resolution of the test
signal. Therefore, if the used sound output devices (e.g. audio interfaces, amplifiers) have
their own hardware level controls then use them to attenuate the output signal and set the
slider in CONEQ™ Workshop to the maximum level.

The output signal level setting is remembered for the current session but is reset to the
safe -30dBFS level on the next start of the CONEQ™ Workshop application.

IMPORTANT! Be careful to set the playback volume to a safe level to avoid distortion, prevent dam-
aging the equipment, and exclude possible damage to hearing.

Initially, the primary soundplayback device is selected by default. Later, the samedevice
and channel as used in the last newmeasurement is selected by default. The device choice
is saved across sessions.

If the selected playback device is an ASIO device, then the Configure... button is enabled
and brings up the ASIO control window, provided by the driver manufacturer. Selecting an
ASIO device for playback will select the same device also for recording.

Recording device

A recording device and a channel for receiving the test signalmust be selected. Typically this
is a sound card and channel where the measurement microphone is connected. The sen-
sitivity must be adjusted so that the incoming signal is loud enough but does not clip. This
must be done by using the means provided by the audio interface or microphone pream-
plifier.

Initially, the primary sound recording device is selected by default. Later, the same de-
vice and channel as used in the last new measurement is selected by default. The device
setting is saved across sessions.

If the selected recording device is an ASIO device, then the Configure... button is enabled
and brings up the ASIO control window, provided by the driver manufacturer. Selecting an
ASIO device for recording will select the same device also for playback.

If the selected recording device is APEQ-8pro DIO, then clicking the Configure... but-
ton brings up the APEQ-8pro DIO recording configuration dialogue (figure 14). This allows
switching on the phantom power and adjust the sensitivity level of the microphone input.
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Figure 14: The APEQ-8pro DIO recording configuration dialogue.

Measurement name

Each measurement needs a name by which it will be shown in the measurements list. The
name is entered in the Measurement name field. It is not recommended to give several
measurements the same name. Measurements can be renamed later.

Test signal period length

The test signal period length must be selected. There are four different lengths provided:
0.341, 0.683, 1.365, and 2.731 seconds. The default period of 0.341 seconds is suitable
for small to medium size rooms. Longer sweep periods are required for larger and very
reverberant or very noisy venues, or when measuring low frequency drivers (subwoofers).

Recording sample rate

The measurement sample rate must be selected. 48 and 96 kHz sample rates are sup-
ported. It is recommended that the measurement has the same or higher sample rate than
the filters that will be generated from it. Otherwise, themeasurement will provide no useful
information for equalization of the highest frequencies. It is recommended to always use
96 kHz recording sample rate if the audio interface supports it.

Using presets

Presets are user-defined sets of parameters for newmeasurements and filters. Presets can
be edited by using the Preset Editor (see page 37). The new measurement uses parameter
values from the preset that is chosen in the Use preset field. The default selection in the
Use preset field is <Default for this project>.

Ways to stop the measurement

There are three choices for how to stop the measurement once it is started:

Manually, by pressing the Start/Stop measurement button;

After a fixed time in seconds;

After a fixed number of test signals.
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Taking the measurement

Click the Start test signal button to start playing the test signal on the selected playback
device and channel. This also initiates monitoring of signal level on the selected recording
device and channel. The button text will change to Stop test signal.

While the test signal is playing, the output signal level and input sensitivity should be
adjusted so that the peak level indicator is predominantly between -30 and -5 dB levels
(the ”>” and ”<” marks, respectively). The level meter should never fill completely because
that means signal clipping (overload). If that happens then the volume or sensitivity should
be reduced.

When the input level is adjusted appropriately, click the Start Measurement button to
start the measurement. There are situations when some time is needed to prepare for the
measurement (e.g. the speakers are far from the computer). For such cases it is possible to
specify the time towait until the actual recording starts after the Start Measurement button
has been pressed.

When the measurement is started, the progress bar will show the measurement
progress. Just above the progress bar, elapsed time in seconds and the number of recorded
test signals is displayed. The Cancel button can be used at any time during the measure-
ment to stop themeasurement process. The newmeasurement windowwill not be closed,
however. To close it, use the window close button in the top right corner.

After a successful measurement is made, the newmeasurement windowwill close. The
first filter for the new measurement will be calculated based on the preset that was used
for the measurement. The new filter will be selected in the measurements list.

MEASUREMENT MENU

The figure 15 shows the Measurement menu which provides means to create, import,
delete, and rename measurements as well as produce a composite (average) measure-
ment.

Figure 15: The Measurementmenu.
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New...

Create a new measurement. It was described on page 15.

Delete

Delete the currentmeasurement from the project. Themeasurement data alongwith all the
corresponding filters will be removed from the project. The corresponding measurement
folder from the project folder will be moved to the Recycle Bin (Windows) or Trash (Mac).
This is done to allow recovery of measurement data if it was deleted by accident.

Rename

Rename the current measurement.

Create from file...

Create a measurement from a file that contains a recorded sequence of test signals. This
is useful for cases when it is impossible to record the test signal with the same computer
that is generating the test signal or as a way to import measurements from other projects
(including previous versions of CONEQ™ Workshop).

The file must be a 48 or 96 kHz, 16 or 24-bit, signed little-endian integer PCMmono file
in WAV format.

Composite...

CONEQ™ Workshop allows producing a ”measurement” that is an average of the acoustic
power frequency responses of several measurements. The composite result is an average
of the components calculated in the acoustic power domain. Composite measurement is
used, for example, to exclude anymeasurement error by repeating the samemeasurement
several times, or make a measurement of the full measurement surface that is impossible
with a single measurement because of technical or physical limitations.

Any number of measurements in the current project can be selected. It is possible to
adjust the level of each measurement relatively to others. Increasing the level means that
the measurement will be more dominant in the composed result.

A particular filter version from each measurement must be selected for composition.
Information about the filter version is needed because filters define APFR zero level adjust-
ment, time window and correction curves – parameters that influence the acoustic power
frequency response.

The figure 16 shows the measurement composition window and table 3 describes the
meaning of controls.
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Figure 16: The measurement composition window.

Table 3: The composite measurement window controls.
Field Description
Composite name The name of the resulting composite ”measurement”.
Use preset Use the settings from the selected preset for the first equaliza-

tion filter calculated from the composite.
Measurements All measurements of the current project are listed. Use check-

boxes on the left of the measurement name to include the
measurement in the composition. The measurement name is
followed by the index of the currently selected filter that will
be used for composition. The APFR level adjustment value is
shown in the second column.

Zero level Adjust the APFR level of the selected measurement. This way
the ”importance” of each included measurement can be ad-
justed.

Filter version Select the filter version of the currently selectedmeasurement
which will be used for the composition.

Graph area The graph shows the APFRs of the checkedmeasurements. The
graph of the selected measurement is highlighted. The graph
can be zoomed in or out on both axis. Use the mouse wheel to
zoom in and out vertically. Hold the Ctrl key (Shift on Mac) to
zoom horizontally.

Calculate button Start the composition process.
Cancel button Close the window.
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FILTERS

The parameter area (figure 17) at the top right of themain window shows the parameters of
the currently selected filter. All the parameters that determine how a CONEQ™ equalization
filter is generated can be adjusted in the multiple tabs of the parameter area.

Figure 17: The filter parameter area.

At the bottom left of the parameter area, there is a button Recalculate filter to create a
new filter based on the chosen parameter values. On the bottom right there are controls to
upload the currently selected filter to an APEQ™ hardware equalizer, if one is connected. At
the bottom centre there is a button Presets... to apply predefined sets of parameter values
and to open Preset Editor (see page 37).

FILTER PARAMETERS
Correction range

Figure 18: The correction range parameters.

The CONEQ™ equalization will only be applied in a certain frequency range (typically the
frequency range of the loudspeakers). There are two ways to specify the start and end
frequencies of the CONEQ™ correction range.

One way is to specify the level of the APFR at which the equalization should start/end.
In this case the start (end, respectively) frequency will be the lowest (highest) frequency
at which the APFR level is at least the specified level and is at least 10 dB over the
noise/distortion level. This is the default and suggested way for typical loudspeakers.
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The other way is to specify explicitly the frequencies at which the equalization should
start/end.

The maximum boost and maximum attenuation of the equalization filter will be limited
to levels in the respective fields. This is to prevent too much gain leading to distortion or
even damaging the speakers and too much attenuation reducing the maximum power of
the speakers. These parameters limit the filter to be in the specified bounds regardless of
the APFR zero level adjustment, target curves, and correction curves. The produced equal-
ization filter will never exceed these maximum boost and attenuation limits. The low/high
frequency cut settings (see Out-of-range EQ settings tab on page 23), however, override
these limits.

The Show correction range check-box controls the visibility of the correction range on
the graph.

Resolution

Figure 19: The filter resolution parameters.

CONEQ™ Workshop allows generation of filters for the following products supporting
CONEQ™ equalization filters:

APEQ-2pro/2pro DIO hardware

APEQ-8pro DIO hardware

CONEQ P2/P8 plug-in

CONEQ P2pro/P8pro plug-in

CONEQ™ COMPATIBLE product (1024 taps)

CONEQ™ COMPATIBLE product (4096 taps)

Choosing a tool will select the maximum filter resolution (precision of the filter) sup-
ported by the corresponding tool. The Number of taps field shows the precision of the filter.
The more taps a filter has the better the precision.

For CONEQ™ equalization the sample rate of the filtermustmatch the sample rate of the
audio signal. Therefore, for tools that support several sample rates, it is possible to select
the filter sample rate from the Sampling rate selection list. The list adapts to the chosen
equalizer type. For the APEQ-2pro/2pro DIO hardware it is always set to 48 kHz, for the
APEQ-8pro DIO hardware the supported sample rates are 44.1, 48, 88.2, and 96 kHz. For
CONEQ™ plug-ins and CONEQ™ COMPATIBLE products the allowed sample rates are 250,
500 Hz, 1, 8, 16, 32, 44.1, 48, 88.2, and 96 kHz.
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Smoothing

The CONEQ™ equalization filters are generated from a smoothed APFR and not the originally
measured one. This is done to avoid compensating for small APFR irregularities thatmay not
be real defects of the speakers but rather are measurement errors. The APFR is smoothed
using a raised cosine impulse filter with a resolution from 1/6th (more precise) to a full
octave (more smooth).

Filter description

The Filter description field can be used to describe the particular filter version. If used, the
filter description will appear behind the corresponding filter entry in the measurement list.

OUT-OF-RANGE EQ

Figure 20: Out-of-range gain and low/high frequency cut parameters.

Frequencies below the correction range will be boosted/attenuated by the value speci-
fied in Gain below correction range. Frequencies above the range will be boosted or atten-
uated by the value specified in Gain above correction range. The maximum value of both
shelves is 20 dB and the minimum is -60 dB.

The high and low frequency cuts are useful for equalizing speakers with limited fre-
quency range. They allow to remove frequencies from the audio stream that the speakers
are anyway not able to reproduce.

The values in the Low/High frequency cut fields override other limits such as maximum
boost/attenuation or target EQ curves.

TARGET EQ

When no target EQ curves are used, CONEQ™Workshop creates a CONEQ™ equalization fil-
ter that achieves flat frequency response. Sometimes flat frequency response is not desired
(relative HF loss over the distance, ”club-sound”, correction for hearing defects, etc.). In
such cases, the Target EQ tab (see figure 21) allows specifying the desired frequency re-
sponse of the system after the CONEQ™ equalization filter is applied.

One or more target EQ curves can be added together to produce the final target EQ that
will be applied on top of the CONEQ™ equalization andmade into a single equalization filter.
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IMPORTANT! Target EQ is not a fine-tuning tool but an advanced feature that can help in the more
complex situations when it is impossible to measure in a way that a default equalization to flat fre-
quency response can be applied or for specific caseswhen a non-flat frequency response is needed.

Figure 21: The Target EQ tab.

Clicking the Parametric EQ button adds a curve that can be specified using familiar con-
trols of a parametric EQ. Clicking theGraphic EQ button adds a curve that runs through freely
placed nodes on the frequency/amplitude plane. Clicking the From File... button adds ei-
ther a previously saved Parametric or Graphic EQ curve, or a curve from a text file containing
frequency-gain value pairs, or any .DAT or .FIR file (see table 13). The final target EQ curve
will be the sum of all the target EQ curves from the list.

Selecting a curve in the target EQ curve list will display the curve in the Graph area.
Clicking the Edit button or clicking directly on the target curve in the Graph area will enter
editing mode (for graphic and parametric EQ curves only).

Clicking the Delete button will remove the currently selected target EQ curve from the
list.

Clicking the Save button will save the currently selected target EQ curve (for graphic and
parametric EQ curves only) to a file. This way a target EQ curve can be reused for other
filters and/or projects.

Double-clicking on the name of the target EQ curve allows giving it a descriptive name.

Using Parametric EQ

Parametric EQ allows defining a target curve using the familiar concept of parametric equal-
izer. There can beup to twelve bands of equalization in one curve. Ifmore bands are needed,
more curves can be added. Each band can work in either Low Shelf, Low Pass, Band Pass,
Hi Pass, or Hi Shelf mode. All modes have adjustable centre frequency. Low Shelf and High
Shelf additionally have adjustable amplitude. The Band Pass filter additionally has an ad-
justable bandwidth (Q). Low Pass and High Pass filters have a fixed 24 dB/octave slope.

Selecting the curve in the target curve list will display the curve in the Graph area. Click-
ing the Edit button or directly on the target curve in the Graph area will enter editing mode.
In this mode (see figure 22), a window with band parameters will open.

To use a band, switch it on, select a mode and adjust parameters. All parameters can be
specified by writing a number in the corresponding field. Amplitude and bandwidth can be
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Figure 22: The parametric EQ in edit mode.

adjusted by pressing the mouse button while the cursor is on the corresponding field and
moving mouse up or down. The frequency adjustment is the same except that the mouse
is to be moved to the left or right.

Pressing the Enter key or clicking the OK button ends the editing mode and accepts the
changes made. Pressing the Esc key or clicking the Cancel button will discard the changes.

Using Graphic EQ

Graphic EQ allows defining arbitrary target curve that runs through freely placed nodes on
the frequency/amplitude plane. The EQ curve will be formed by connecting the nodes with
straight lines.

Selecting the curve in the target curve list will display the curve in the Graph area. Click-
ing the Edit button or directly on the target curve in the Graph area will enter editing mode.
In this mode (see figure 23), small rectangles will be displayed for the nodes that define the
curve. Dragging a node will change its location. Dragging a node and dropping it outside the
graph area will remove the node. Clicking on a location on the graph area where there are
no nodes, will create a new node.

Pressing the Enter key ends the editing mode and accepts the changes made. Pressing
Esc will discard the changes.
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Figure 23: The graphic EQ in edit mode.

Using target EQ files

The target curve can be specified as a text file with one or more lines where each line con-
tains frequency value in Hz, a Tab or Space character and the gain/attenuation value in dB.
Lines starting with a semicolon (;) character are comments and can contain arbitrary text.
An example of a target curve file is shown in the table 4

Any .DAT or .FIR file created by CONEQ™Workshop (see table 13) can also be used as a
target EQ file. This feature can be used, for instance, to make one loudspeaker sound like
another loudspeaker by specifying the measured APFR curve (..._PRS.DAT) of the other
loudspeaker as the target EQ.

MEASUREMENT ADJUSTMENT

The Measurement adjustment tab (figure 24) allows adjusting parameters that determine
how the APFR of the measurement looks like, thus, affecting the generation of the equal-
ization filter. There are three ways how the measurement can be adjusted – adjusting the
zero dB level of the APFR, applying a time window to the measured impulse response, and
applyingmicrophone calibration and audio interface frequency response correction curves.
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Table 4: The format of a target EQ file.

; This is an example
; of a target EQ file
698.46 0
783.99 0
880 0
987.77 0.83
1108.73 1.67
1244.51 2.5
1396.91 3.33
1567.98 4.17
1760 5
1975.53 4.17
2217.46 3.33
2489.02 2.5
2793.83 1.67
3135.96 0.83
3520 0
3951.07 0
4434.92 0

Figure 24: The Measurement adjustment tab.

APFR zero level adjustment

The APFR zero level can be adjusted if the default automatic adjustment is not optimal. One
reason to do this is to align the APFR and the desired target curve so that the generated
equalization filter fits better in the defined limits for maximum gain and attenuation. An-
other reason iswhenmeasuring speakerswith very limited frequency range (high frequency
drivers or subwoofers in particular) then CONEQ™Workshop tends to place the APFR so that
it is above the 0dB level across the whole correction range. This is not desired as the equal-
ization filter would attenuate all frequencies in the correction range effectively reducing the
sound volume.

The APFR zero level can be adjusted also in the Graph by clicking on the APFR curve and
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dragging it up or down.

Time window

The time window determines what part of the measured impulse response is used to cal-
culate the APFR. The default is a 50ms window (050_40Hz) that is suitable for most typ-
ical cases. Using a longer time window (100_20Hz or even 200_10Hz) is useful to mea-
sure low frequency drivers more precisely. For limited bandwidth speakers having negli-
gible response in low frequencies (e.g. small ceiling speakers) use a shorter time window
(025_80Hz, 015_130Hz, etc.). In general, the shorter the time window the less of the re-
flected sound is taken into account when calculating the APFR but also the less low fre-
quencies can be measured.

Correction curve files

To compensate for the deviations from flat in the frequency response of the used micro-
phone or audio interface, correction curve files can be used. Microphone calibration files
are typically available for high quality measurement microphones. The correction curve file
format is the same as for the target EQ files (see page 26).

There are other factors that can be compensated by using the correction curve files, for
instance, uneven frequency response of an audio interface. To correct the frequency re-
sponse of an audio interface, a loopbackmeasurement should be done first. Then, the filter
folder of the created filter must be browsed to find the frequency response file (*._PR.DAT,
see page 13). This is the file that can be used subsequently as a correction file for other
measurements with this audio interface.

MEASUREMENT INFO

Figure 25: The measurement details window.

The figure 25 shows theMeasurement info tab that displays the parameters of the cur-
rent measurement. The table 5 lists all the fields and their meaning.

For composite measurements, only the Name field is meaningful and other fields will
display zero.
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Table 5: Fields on the Measurement info tab.
Field name Field description
Name The name of the measurement. The name is assigned

before the recording of the measurement. It can be
changed by editing it here and clicking the Rename but-
ton.

Length The length of the measurement in seconds.
Measurement points The number of recorded test signals that are used to cal-

culate the acoustic power frequency response.
Sample rate The sample rate used to record the measurement.
Test signal length The test signal period in seconds.

APEQ™ HARDWARE CONTROL PANEL

On the lower right of the Parameters area there is a small set of controls (see figure 26) for
uploading filters directly to the APEQ™ hardware equaliser, if one is connected.

Figure 26: The APEQ™ hardware control panel.

When an APEQ™device is connected to the computer, and a compatible filter is selected
in the measurement list, the controls get enabled. Clicking the Upload filter to APEQ... but-
ton will open a menu as in figure 27. Selecting a channel will upload the current filter to the
selected channel of the hardware. Selecting Upload to all channels will upload the filter to
all channels of the hardware. If more than one APEQ™ device is connected to the computer
then the Select APEQ devicemenu item allows selecting the one which will be used for fil-
ter upload. For more sophisticated filter management it is possible to launch the APEQ™
Communication Tool (C2).

Figure 27: The channel selection menu of the APEQ™ hardware control panel.

Only filters with sample rate of 48 kHz can be uploaded to the APEQ-2pro/2pro DIO
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hardware units. The APEQ-8pro DIO hardware units support filters with 44.1, 48, 88.2, and
96 kHz sample rates.

The Bypass check-box is enabled for the APEQ-8pro DIO devices and allows switch-
ing CONEQ™ filtering temporarily off. This way, a quick comparison can be made between
filtered and non-filtered sound.

FILTER MENU

Figure 28: The Filtermenu.

Recalculate

Creates a new filterwith the current set of parameters. The current filterwill not be affected.
This is the same functionality as pressing the Recalculate filter button on the parameters
area.

Apply changes

Applies the current set of parameters to the current filter.

IMPORTANT! Any changes to filter parameters have to be confirmed by either applying changes
to the current filter or recalculating a new filter. Unconfirmed changes to any parameter (levels,
limits, EQ curves, filter description, etc.) will be lost when another filter is selected or the project is
closed.

Delete

Deletes the current filter.

Open filter folder

Opens the folder of the filter by means of the operating system. This is useful for accessing
the filter file and various curve files that were described on page 13.
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Save graph image...

Save the currently displayed graph, including a legend as a PNG image.

Export coefficients...

Export the CONEQ™ filter as a .CSV file containing coefficients of a finite impulse response
(FIR) filter for use in CONEQ™COMPATIBLE third-party products. A special license is required
to be able to export filter coefficients for CONEQ™COMPATIBLE products. The CONEQ™COM-
PATIBLE program is described in greater detail in the CONEQ™ COMPATIBLE Program User's
Guide document.

GRAPH

The Graph is the area in the lower part of the main window that visualizes data either in
frequency domain (APFR, filter EQ, etc.) or time domain (impulse response, time window).

The current Graph image with a legend can be saved by choosing Filter⇒Save graph
image... from the menu or by right-clicking on the graph area and choosing Save graph
image... from the context menu.

The Graph supports zooming (see page 35) and display of data from several measure-
ments and filters (see page 34)

It is posible to change the colours of the curves by clicking on their colour patches in the
legend or by adjusting program options (see page 38)

FREQUENCY DOMAIN VIEW

When the frequency domain view is selected (figure 29) the graph shows frequency domain
data (such as APFR, filter EQ, etc.) with Hz on horizontal axis and dB on vertical axis.

The frequency domain view is selected by clicking on the Frequency response tab at the
top left corner of the Graph.

The following frequency domain data of the currently selected filters can be visualized:

Acoustic Power Frequency Response (APFR)

Noise/Distortion

Total Target EQ

Expected APFR after equalization

Filter EQ

Deviation of filter EQ from desired equalization

Each individual Target EQ

Microphone and audio interface correction curves
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Figure 29: The frequency domain view of the Graph.

To show a curve, check the box in front of the corresponding curve name on the legend
at the lop left part of the Graph area.

Additionally to that, frequency domain curves from other measurements/filters and
from external files can be shown (see page 34).

Current APFR

The current APFR curve (green) shows the acoustic power frequency response of the cur-
rently selected measurement after APFR zero level adjustment, time window, and correc-
tion curves had been applied. By clicking on the APFR curve of the current filter and dragging
it up or down, it is possible to adjust the APFR zero level. The changes, as usual, must be
confirmed by either creating a new filter or applying the changes to the current filter.

Noise/Distortion

The noise/distortion curve (cyan) can be used to determine how much noise was present
during the measurement. It also shows the effect of the non-linear distortions. If the
noise/distortion curve is less than 10 dB below the APFR within the correction range then
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the measurement and the resulting equalization filters are not reliable.
Technically, noise/distortion curve is calculated from the end of the impulse response

in the same way as the APFR is calculated from the beginning.

Target

The target curve (blue) shows the desired frequency response of the speakers after applying
the equalization filter. It shows the sum of individual target curves defined on the Target EQ
tab. See page 23 for more information on editing the individual target EQ curves. When no
target EQ curves are defined, the total target EQ curve is a line at 0dB, meaning that the
resulting equalization will aim to produce a flat frequency response.

Expected APFR

The expected APFR shows a good approximation of what the APFR will look like when actu-
ally measuring the speakers after the corresponding CONEQ™ equalization filter is applied.
Ideally, this curve should match the target curve exactly. There are several reasons why
there can be deviations:

Maximum gain/attenuation settings

Correction range settings

Shelf and cut-off settings

Difference of the measured APFR and smoothed APFR

Difference of the generated filter and the smoothed APFR due to insufficient filter res-
olution (number of taps)

Filter EQ

The filter EQ curve (yellow) shows what the CONEQ™ equalization filter looks like as an
equalizer curve. The Invert check-box can be used to invert the filter EQ curve around the
0dB level. This view allows seeing how closely the equalization filter matches themeasured
APFR.

Target error

The target error curve (white) shows how much the generated filter differs from the
smoothed APFR used to generate it. Use this curve to evaluate the quality of the filter –
the more it looks like a line at 0dB the better. The bigger the filter resolution (the number
of taps) the more flat is the target error curve.
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Individual target EQ curves

When an individual target curve is selected on the Target EQ tab, it is also displayed on the
Graph. For parametric EQ and graphic EQ curves, clicking on the displayed curve will enter
the edit mode. See page 23 for more information on editing the individual target EQ curves.

When the current filter selection changes, the individual target curve is removed from
the Graph.

Correction curves

If the microphone calibration curve or audio interface correction curve is specified on the
Measurement adjustment tab (see page 27) then the corresponding curve can be displayed
on the Graph.

Range markers

This check-box triggers greying out of the frequencies belowand above the correction range
as defined on the Filter parameters tab (see page 21).

TIME DOMAIN VIEW

When the time domain view is selected (figure 30) the graph shows time domain data - the
measured impulse response of the currently selected measurement and the time windows
used for the currently selected filter. The horizontal axis showsmilliseconds and the vertical
axis shows dB.

The time domain view is selected by clicking on the Impulse response tab at the top left
corner of the Graph.

QUICK COMPARE FEATURE

There are caseswhen severalmeasurements need to be compared (e.g. left and right chan-
nels, frequency response before and after CONEQ™ equalization, two different speakers,
etc.). For such cases there is a possibility to add up to six curves to the Quick compare list.
The list is shown on the bottom left part of the Graph area. Each entry in the list has a unique
colour. Each Quick compare curve can be adjusted vertically by dragging it up or down on
the Graph area. The Quick compare list is saved for each project.

Adding curves to the Quick compare list

There are two ways how to add curves to the Quick compare list. The simplest is to press
the Ctrl key and click on a filter in themeasurement list. This marks the corresponding filter
as used for comparison and adds a curve from that filter to the Quick compare list. Ctrl-
clicking on the marked filter again removes all curves of that filter from the Quick compare
list and unmarks the filter.

The second way is to right-click on the Quick compare header area (the gray rectangle
with the words Quick compare in it) and selecting the desired curve from the menu that
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Figure 30: The time domain view of the Graph.

opens. This way must be used to add curves from external files (such as curves from other
projects or curves generated by other applications).

Visually, marked filters are similar to the selected filter but have a dark gray background.
On Mac, marked filters have an icon of an eye shown on the right side.

The figure 31 shows the Quick compare list with two curves added. One of the curves
is from another filter in this project but the other curve is loaded from an external file (a
microphone calibration file in this case).

ZOOM

The Graph supports changing the vertical and horizontal scale by either clicking on appro-
priate zoom control buttons (see figure 32) or by operating the mouse wheel.

Using mouse, the vertical scale of the graph can be changed by positioning the mouse
cursor over the Graph and turning the scroll wheel on the mouse. The scale is changed in
6dB increments. The horizontal scale can be changed by holding the Ctrl key (Shift key on
theMac) and turning the scroll wheel on themouse. Thehorizontal zoom takes place around
the horizontal position (frequency or time) on which the mouse pointer is located. The
vertical zoom on time domain data acts similarly but on frequency domain data is centred
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Figure 31: Two curves added to the Quick compare list

Figure 32: The zoom controls.

around the middle line (typically, 0dB) in the graph.
It is possible to move the visible range in any direction by using arrow buttons on the

zoom controls.
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PRESETS

Presets in CONEQ™Workshop are named sets of parameters that can be used when creat-
ing or importing measurements to set many measurement and filter parameters at once.
Presets can be edited using the preset editor (see figure 33) which can be invoked by se-
lecting the Tools⇒Presets... menu or by clicking the Presets... button on the main window
and selecting Preset editor... from the pop-up menu.

Figure 33: The preset editor.

There are two special presets named <Default for new projects> and <Default for this
project>. The <Default for this project> is a set of parameters that will be used by default
for all newmeasurements made in this project. The <Default for new projects>will become
the <Default for this project> for every new project. These two presets can be modified the
same way as other presets. The <Default for this project> preset is saved for each project
while all the other presets are saved globally and are the same for all projects.

CREATING A NEW PRESET

To create a new preset, open the preset editor and edit the parameters. Then click the Save
button. In the dialogue that opens, enter the name of the new preset. If an existing preset
is selected from the list then it will be overwritten with the new values.

To create a preset that uses the settings of the current filter, simply open the preset
editor (it will open initialized with settings from the filter parameters area) and save the
preset.

APPLYING A PRESET TO CURRENT FILTER

To apply an existing preset to the current filter, click on the Presets... button on the main
window and select the desired preset from the pop-up menu. Then click the Recalculate
filter button (or choose Filter⇒Apply changes from the menu).
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DELETING A PRESET

Press the Delete button in the preset editor. In the dialogue that opens select one or more
presets to delete.

OPTIONS

There are a few settings of the CONEQ™Workshop application itself that can be adjusted by
opening the options window (figure 34). The options window can be opened by choosing
Tools⇒Options from the menu.

Figure 34: The options window.

The table 6 lists the available options and describes their effect.

TECHNICAL SUPPORT

Please feel free to contact us at any time about any difficulties using CONEQ™ Workshop
software (our contact details are listed below). We will do our best to respond to you as
quickly as possible. Our mission is to make your experience with CONEQ™ as simple and
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Table 6: The CONEQ™ Workshop options.
Option Description
Language The language of the user interface. Currently supported

are English (default) and Chinese. Changing the language
requires a restart of the CONEQ™ Workshop application.

Default project folder Use the location by default on opening and creating new
projects.

Open last project on pro-
gram start

Open the last used project when CONEQ™ Workshop
starts.

Generate linear phase filters Besides the standard minimum phase filter files, create
also the linear phase version for each filter.

Enable ASIO Enable using ASIO devices for taking measurements.
Recording WAVE device bit
resolution

Set bit resolution for WAVE devices to 16 bits to support
some audio interfaces that have problems recording in
24 bits using WAVE drivers (e.g. Terratec Phase 22).

Measurement settings for
new projects

Click the Edit... button to open preset editor and edit
the default measurement and filter settings for all new
projects.

Colours Specify colours for the various graphs.
Make background of the
saved images transparent

Allows putting saved images on some custom back-
grounds for maximum flexibility. Note: If the saved im-
age is to be put on light background, select the back-
ground for saved images to be light as well. Even though
the specified background colour will not be present in the
saved image, the setting will influence the colours of the
axis labels and colour of the legend texts.

Frequency domain grid Specify the default vertical scale and number of grid lines
for the frequency response graphs.

Time domain grid Specify the default vertical scale as well as the number of
vertical and horizontal grid lines for the impulse response
graphs.

Reset colours button Revert to the default colours.
OK button Accept the changes and closes the options windows.
Cancel button Close the options window without saving changes.

rewarding as possible. To help us resolve issues quickly, we might need one or more of the
following data:

CONEQ™ Workshop software edition and version (It can be found in Help⇒About).

The operating system: Windows XP, Windows Vista or Windows 7, U.S. or international
version, OEM or stand-alone software package.

Computer information: CPU type and speed, installed memory.
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Description of the problem (asmuch information for us to understand the problem as
possible).

CONTACTING REAL SOUND LAB

Should you have questions or comments, please contact us using one of the followingways:

E-mail: support@realsoundlab.com

WWW: www.realsoundlab.com

Phone: +371 6788 9828 (Real Sound Lab SIA Headquarters, Riga, Latvia)

Thank you for choosing CONEQ™!
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CONEQ™ USER LICENSE AGREEMENT

CONEQ™ User License Agreement
IMPORTANT: Please read this License Agreement carefully. By installing and using all or

any portion of the CONEQ™software anddocumentation (Software) you accept all the terms
and conditions of this License Agreement.

This document is an agreement between you (an individual or a business) andReal Sound
Lab SIA and/or its affiliates (the specific reciprocal party to this agreement may be based
on where you reside). Your use of the Software indicates your acceptance of these terms.

You may have another written agreement directly with Real Sound Lab SIA that supple-
ments or supersedes all or portions of this License Agreement.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, YOU MAY RETURN INTACT
AND UNOPENED, THE SOFTWARE PACKAGE TOGETHER WITH THE OTHER COMPONENTS OF THE
PRODUCT, TO THE PLACE OF PURCHASE FOR A FULL REFUND OF THE PURCHASE PRICE. IF YOU
DO NOT ELECT TO RETURN THE SOFTWARE AND ITS RELATED COMPONENTS WITHIN 30 DAYS
FORM THE DATE OF YOUR RECEIPT OF SAME, YOU WILL BE DEEMED TO HAVE AGREED TO THIS
LICENSE AGREEMENT IN ITS ENTIRETY.

Real Sound Lab SIA owns all intellectual property in the Software. The Software is li-
censed, not sold.

Real Sound Lab SIA permits you to download, install, use or otherwise benefit from the
functionality or intellectual property of the Software only in accordance with the terms of
this License Agreement.

As used in this License Agreement, the term ”Software” means the software down-
loaded from the internet, or otherwise acquired, and/or included on the CD or portable
flash media provided with this License Agreement.

The Software is delivered with the eLicenser USB device that is designed to prevent
unauthorized use and copying and enforce license restrictions. The eLicenser protection
technologymay prevent your use of the Software if you do not follow the installation and/or
licensemanagement process described in the Software and documentation or if you use the
Software in a way not permitted by this License Agreement.

1. PROPRIETARY RIGHTS. The Software and any accompanying documentation are the
proprietary products of Real Sound Lab SIA and/or its licensors. The structure, organization
and code of the Software are the valuable trade secrets and confidential information of Real
Sound Lab SIA and/or its licensors. The Software and any accompanying documentation
are protected under national laws and international treaty provisions. Ownership of the
Software and all copies, modifications, translations, and merged portions thereof shall at
all times remain with Real Sound Lab SIA and/or its licensors. This License Agreement does
not grant you any intellectual property rights in the Software and all rights not expressly
granted are reserved by Real Sound Lab SIA and/or its licensors.

2. GRANT OF LICENSE. The Software and accompanying documentation are being li-
censed to you, whichmeans you have the right to use the Software only in accordance with
this License Agreement. The Software is considered in use on a computer when it is loaded
into temporarymemory. This Licensemay not be assigned, or otherwise transferred, with-
out prior written consent from Real Sound Lab SIA, and any unauthorized transfer is there-
fore null and void.
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Youmay install the Software on any number of computers but you are authorized to use
the Software only on one computer at any time.

The Software is licensed for your own personal use if you are an individual or for your
own internal business purposes if you are a business. Explicitly excluded from the license
is using CONEQ Software to derive correction filters for use in devices or software other
than those that are produced by Real Sound Lab SIA or certified by Real Sound Lab SIA to be
CONEQ™ COMPATIBLE. For such use a separate license from Real Sound Lab SIA is required.

BACKUP COPY. In addition to any copies authorized under this License Agreement, you
may make a single copy of the Software solely for backup purposes, provided your backup
copies are not installed or used for other than archival purposes.

UPDATES AND SUPPORT. You are entitled to receive technical support as outlined in the
Software documentation. You are entitled to receive Software updates (updates shall in-
clude any patches or bug fixes that Real Sound Lab SIA makes generally available at http:
//www.realsoundlab.com) in accordance with Real Sound Lab SIA policies as announced
from time to time on terms comparable to those offered to other users of the Software un-
der similar licenses. In order to receive Software updates, you must possess a valid license
to a previous version of the Software.

3. NON-PERMITTED USES. Any permitted copy of the Software that youmakemust con-
tain the same copyright and other proprietary notices that appear on or in the Software.

No Modifications. You may not modify, adapt or translate the Software. You may not
reverse engineer, decompile, disassemble or otherwise attempt to discover the source code
of the Software.

No Unbundling. The Software may include various applications, utilities and compo-
nents, may support multiple platforms and languages and may be provided to you on mul-
tiple media. Nonetheless, the Software is designed and provided to you as a single product
to be used as a single product on your computer. You are not required to use all component
parts of the Software, but you may not unbundle the component parts of the Software for
use on different computers. You may not unbundle or repackage the Software for distribu-
tion, transfer or resale.

No Transfer. YOU MAY NOT RENT, LEASE, SELL, SUBLICENSE, ASSIGN OR TRANSFER YOUR
RIGHTS IN THE SOFTWARE, OR AUTHORIZE ANY PORTION OF THE SOFTWARE TO BE COPIED ONTO
ANOTHER INDIVIDUALOR LEGAL ENTITY‘S COMPUTER. Youmay, however, permanently trans-
fer all your rights to use the Software to another individual or legal entity provided that: (a)
you also transfer (i) this License Agreement, (ii) the Software and all other software and/or
hardware bundled, packaged or pre-installed with the Software, including all copies, up-
grades, updates and prior versions, (iii) the eLicenser device; (b) you retain no upgrades,
updates or copies, including backups and copies stored on a computer; and (c) the receiv-
ing party accepts the terms and conditions of this License Agreement and any other terms
and conditions under which you purchased a valid license to the Software. Prior to a trans-
fer Real Sound Lab SIA may require that you and the receiving party confirm in writing your
compliancewith this License Agreement, provide Real Sound Lab SIAwith information about
yourselves, and register as end-users of the Software.

4. COMPLIANCE WITH LICENSES. If you are a business, company or organization, you
agree that upon request from Real Sound Lab SIA or its authorized representative you will
within 30 (thirty) days fully document and certify that use of any and all Software at the
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time of the request is in conformity with your valid licenses from Real Sound Lab SIA.
5. ONLINE SERVICES. The Software may rely upon or facilitate your access to websites

maintained by Real Sound Lab SIA or its affiliates or third parties offering goods, informa-
tion, software and services. Your access to and use of any website or online services is
governed by the terms, conditions, disclaimers and notices found on such site or other-
wise associated with such services. Real Sound Lab SIA may at any time, for any reason,
modify or discontinue the availability of any website or online services. Real Sound Lab SIA
does not control, endorse or accept responsibility for websites or online services offered by
third parties. Any dealings between you and any third party in connection with a website
or online services, including delivery of and payment for goods and services and any other
terms, conditions, warranties or representations associated with such dealings, are solely
between you and such third party.

6. DEFECT AND LOSS OF THE ELICENSER DEVICE In the case of a defect or damage to the
eLicenser, Real Sound Lab SIA or a third party engaged by Real Sound Lab SIA will check the
eLicenser. In the case of a legitimate claim the eLicenser and the licenses included shall
be replaced in return for a handling fee. The licenses will only be replaced provided that
they are licenses issued by Real Sound Lab SIA. The handling fee will not be charged if the
eLicenser fails within one year of the original purchase. Further claims against Real Sound
Lab SIA are excluded.

Real Sound Lab SIA assumes no liability or obligation if the eLicenser is mislaid as a result
of loss, theft or otherwise. Real Sound Lab SIA reserves the right to block the eLicenser
upon being notified by the user of the loss. The licenses saved on the eLicenser cannot be
replaced.

6. LIMITATION OF LIABILITY. In no event shall Real Sound Lab SIA liability related to any
of the Software exceed the license fees actually paid by you for the Software. Except for
a return of the purchase price under the circumstances provided under the Limited War-
ranty, neither Real Sound Lab SIA nor its suppliers shall, in any event, be liable for any loss,
damages, claims or costs whatsoever arising out of or related to, the use of, or inability to
use, the Software, including but not limited to direct, indirect, special, incidental, or con-
sequential damages, and damages for loss of business profits, business interruption, loss
of business information, or other pecuniary loss, even if Real Sound Lab SIA has been ad-
vised of the possibility of such damages, whether such liability is based on contract, tort,
warranty, or any other legal or equitable grounds. In the event that the territory that you
reside in does not allow the exclusion or limitation of liability for consequential or incidental
damages, the above limitation may not apply to you.

7. NO WAIVER. Any failure by either party to this agreement to enforce a specific part
of the agreement in a specific situation is not a waiver of rights under the agreement. The
party may still enforce the rest of the agreement in such a situation and may still enforce
some or all of the agreement in other situations.

8. This License Agreement constitutes the entire agreement between you and Real
Sound Lab SIA pertaining to its subject matter. This License Agreement is governed by the
laws of the State of California. Any litigation arising from this license will be pursued only in
courts of the State of California. Even if part of the agreement is held invalid, the rest of the
agreement is still valid, binding and enforceable.

Should you have any questions regarding this License Agreement, if you wish to request
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any information or to contact Real Sound Lab SIA for any reason, please use the address and
contact information provided below:

Real Sound Lab SIA
Akademijas laukums 1
Riga, LV-1050, Latvia
www.realsoundlab.com

Copyright 2004-2011 Real Sound Lab SIA. All rights reserved. The Software may be pro-
tected by U.S. and international patents. CONEQ™ is a registered trademark of Real Sound
Lab SIA.

All other product names, logos, brands, and other trademarks referred to within this
Agreement are the property of their respective trademark holders.
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TRADEMARKS

”CONEQ” and ”APEQ” are registered trademarks of Real Sound Lab SIA. ASIO is a trade-
mark and software of Steinberg Media Technologies GmbH. All other product names and
trademarks are property of their respective owners and are used solely for the purpose of
identifying the specific products. Use of the trademarks does not imply any cooperation or
endorsement.
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